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SPECIFICATIONS 
 
Low-level gas flow beta multicounter system for measurement of 5 samples simultaneously. 
 
Sample size: 25 mm. diameter 
 
Counter gas: 99% Argon N48/1% Isobutane N25 (or 99% Argon/1% propane N25) 
 
Sample counter elements: 25 mm diameter with aluminized Mylar window (<1 mg/cm2). 
 
Guard counter: 100 mm x 250 mm x 12 mm. 
 
Background in 100 mm lead shielding: <0.2 CPM (typically <0.15 CPM). 
 
Efficiency: 90Sr/Y (activity prepared on a 25 mm diameter filter paper attached to a 5 mm 
thick Thallium disc): 54%. 
36Cl (activity deposited on a 25 mm. diameter x 5 mm thick plastic disc): 44%. 
14

 C   (1 mm. thick acrylic source, 25 mm diameter): 24%. 
 
99Tc (Electro plated on steel disc): 42% 
 
Size: 
Mechanical unit: 50 x 100 x 250 mm. (Other dimensions on request) disc./anticoincidence 
module: 250x250x65 mm. 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
       
 

Description 
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The basic part of the Risø low-level beta multicounter system is a gas-flow unit with dimensions 
of 50x100x250 mm which incorporates five individual GM sample counter elements and a 
common guard counter (Fig. 1). 

51 2 3 4 6 7 8

   
Fig. 1 The five-sample beta GM multicounter, schematically. 
 
(1) Guard counter, (2) Mylar window, (3) Sample counter, (4) Sample, (5) Sample slide, (6) Lift 
slide, (7) Preamp., (8) Acrylic frame, (9) Cu plate, (10) Anodes. 
 
The guard counter reduces the cosmic-ray background by using anticoincidence technique. Each 
sample counter element is provided with an aluminized Mylar window of density < 1 mg/cm2 
and diameter 25 mm. The counters are gas-flow types designed for 99 % Ar/1 % isobutane or 99 
% Ar/1% propane counter gas. A sample slide allows five samples to be inserted into the 
multicounter and be measured simultaneously. A lift mechanism minimizes the 
sample-to-window distance to obtain optimal efficiency. The multicounter is normally placed 
inside a lead shielding of 100 mm thickness to reduce the ambient background radiation. 
  
Another part is an electronic system for treatment of the signals produced by the beta particles in 
the GM multicounter. A block diagram of the electronic circuit is shown in Fig. 2. Preamplifiers 
placed on the gas flow counter unit produce signals from the individual counter elements that are 
fed to the discriminator/anticoincidence module (see Fig. 3) which also incorporates an 
automatically controlled high-voltage supply. The anticoincidence circuits eliminate the 
background counts produced in the sample counters by cosmic radiation. The net signals from 
the sample counters are fed to a multiscaler/analyser circuit board mounted directly into a slot of 
an IBM-compatible personal computer. A pulse-height analysing system is provided to 
automatically control that the high voltage is maintained at a proper value, i.e. well within the 
GM voltage plateau. The analyser system continuously compensates for varying gas flow and 
atmospheric pressure. 
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The software controls start/stop, re-cycle, preset time and pulse height analysing functions. The 
results of repeated measurements continuously appear on the computer screen by using different 
programs and data files can be stored for further calculations and analyses. 
 
 

MULTISCALER/
ANALYSER BOARD

PERSONAL COMPUTERPRE-AMP.

DISC./ANT. COINC.

HIGH VOLTAGE

GUARD COUNTER

SAMPLE COUNTER

 
 
Fig 2. Block diagram of the electronics for the five sample multicounter. 
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Fig. 3. Discriminator/anticoincidence module. 
 
1.         LED indicators for sample counters 1-5, and the guard counter. 
2.         Main power (LED). 
3.         HV. man. (LED) ON 
4.         HV. man. regulator 500-1500 V (1-10 on potentiometer) 
5.         Bubble chamber (3/4 full with PEG 400 oil) 
6.         Bubble chamber top 
7.         Main power, ON/OFF switch 
8.         Main fuse. 
9. Gas flow regulator 
10.       Gas input (0,2 bar from main gas regulator) 
11.       Bubble chamber (from guard counter) 
12.       Output to GM multicounter unit 
13.       HV output to GM multicounter unit 
14.       Test output HV 0,5-1,5 V  
15.       HV.man. switch (on/off) 
16.       Input from GM multicounter 
17.       Output to personal computer. 
18.  Main supply switch 115/230V. 
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INSTALLATION AND INITIAL START-UP PROCEDURE 
FOR GM-25-5 BETA MULTICOUNTER 

 
1) Read the instruction manual carefully. 
 
2) Fill PEG 400 oil (Polyethylenglycol) (enclosed) into the bubble chamber with a  
 syringe, approximately 3/4. Access to the bubble chamber is made by removing  
 the yellow plate with inscription "CAUTION" This side up" situated on top of the 
 disc/ant. coinc. module. Be sure that the gas flow valve on the rear of the disc/ant. 
 coinc. module(Fig. 3.) is closed (fully clockwise). 
 
3) Connect the gas-alarm unit between the two regulators where the pressure is 8-10 
 bar as shown in Fig. 4. The gas-alarm will beep (0.5Hz) if the pressure is less than 
 6 Bar. If the gas-alarm beeps, then close the gas cylinder and change to a new one 
 as soon as possible. If the gas-alarm beep's every 1 min. the battery (9V) must be 
 changed. 
 
4) Adjust the pressure regulator on the gas cylinder to an output pressure of 0.2 Bar 
 and close the main high pressure valve on cylinder. 
 
5) Connect gas tubes according to the diagram in Fig. 4. 
 NB! The soft gas tubes should be as short as possible. 
 
6) Remove the top of the personal computer and insert the multiscaler/analyser board into a 

free slot. 
 
7) Connect electronic cables between the personal computer and the disc/ant. coinc. 
 module. 
 NB. The personal computer and the disc./anticoincidence module must be switched 
 off. 
 
8) Place the counter unit into the lead shielding and be sure that the sample slide can 
 move smoothly and that cables and gas tubes are placed properly. 
 
9) Open the main valve on the gas cylinder. 
 
10) Slowly open the gas flow valve on the back of the disk./anticoincidence module 
 until a fast but uniform bubble rate is observed in the bubble chamber. Leave the 
 counter in this flushing condition for some hours to remove air from the counter. 
 
11) After flushing, reduce the gas flow control valve to a flow rate of about 
 60 bubbles per minute and leave the counter for 6 hours. 
 
12) Switch on the disc./anticoincidence module. 
 
          
 
 
 
 
Fig. 4. 
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GASALARM

PRESSURE REGULATOR

8-10 BAR

0.2 BAR

REAR OF DISC/ANT. COINC. MODULE

REG. BUBBLE

IN COUNTER

GUARD COUNTER

SAMPLE COUNTER

REAR OF 

MULTICOUNTER GM-25-5

 
Flow diagram of the counter gas connections to the multicounter GM-25-5. The 
pressure from the cylinder is reduced to 0.2 bar and the gas flow is adjusted with 
the flow regulator (reg.) to approx. 50-60 bubbles per min (after warm up). Note 
that the gas is led through the guard counter first and then through the sample 
counters. 
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13) Switch to manual mode by activating the "HV.man." switch on the rear of the 
 disc./anticoincidence module (Fig. 3) (HV.man. LED on the front plate is on). 
 
14) Place the 99Tc test source in position 5, the most distant hole while holding the green 

sample slide and push it into the GM multicounter. Lift the source by inserting the red lift 
slide under the green sample slide. 

 
 15) Slowly increase the high voltage by turning the high voltage potentiometer clockwise. 

Observe the counter LED controls on the front of the disc./anticoincidence module. 
Increase the voltage until the green counter 5 LED is flashing. 

 
 The high voltage should now be about 1100-1400 V. 
 
 Press the "HV.man." switch once on the rear of disc./anticoincidence module (HV.man. 
 LED goes off). The HV supply is now in automatic mode and is awaiting control signals 
 from the GM-25-5 software. 
 
 
 
 
 
 
 Nb! The described manual procedure is only needed for an initial start up of the 
  system. Exchange of gas cylinder can be made without any readjustments. 
 
 Nb! Be careful not to empty the gas cylinder completely which may cause a slight 
  underpressure that can result in oil to be sucked back into the counter unit. A 
  reservoir chamber is placed in connection with the bubble chamber as an 
  emergency arrangement (see Fig. 5.). Access to the bubble chamber and reservoir 
  is made by removing the plastic frames on the front and back of the disc./anti- 
  coincidence module and lifting of the top cover. Oil sucked into the reservoir can 
  be removed by a syringe.                                                                   

FRONT

OIL INPUT

RESERVOIR BUBBLE CHAMBER

TUBE

TUBE

Fig. 5. Bubble chamber and oil reservoir connection. 
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                                       The GM-25-5 software version for Windows 
 
The instructions for the window version of the RISØ GM-25-5 software assume that you are 
familiar with the Microsoft Windows terminology and procedures and that you have installed 
Windows on your computer. 
 
If you have not set up Windows on your computer, or if you are not familiar with the use of 
Windows, please read your Windows documentation. 
 
Hardware and software requirements 
 
You need the following (or better) computer configuration to use the Risø GM-25-5 beta counter 
for Windows: 
 
 Computer: True IBM compatible computer based on a 486 CPU or higher.        

One free ISA slot is needed for the multiscaler/analyser board. 
 
Memory:              Minimum of 16 megabytes of Random Access Memory (RAM) is required. 
 
 
Monitor:              Display with Video Graphics Array (VGA) or better resolution. 
 
 
Mouse:                A Windows-compatible mouse. 
 
 
 
 
 
 
You will need one of the following operating systems to run the Risø GM-25-5 beta counter 
software: 
 
Microsoft Windows version 95/98 or ME.  
 
 
The beta counter will not operate with Win NT, Win 2000 and Win XP. 
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                   Loading the GM-25-5 software for Windows 
 
1. Switch on the personal computer. 
 
2. Load your Microsoft Windows program. 
 
3. Place the GM-25-5 software disk in your floppy drive. 
 
4. Make sure that you are in the Microsoft Windows "Program Manager Window". 
 
5.         Choose "Run" from the file menu to display the Run Dialogue box. 
 
6. In the Command Line Text Box, enter the text: a: install 
 
7. Click OK. The GM-25-5 install program begins. 
 
8. Make a "Program Group" named Beta Multicounter. 
 
 Click "New" from the File menu. 
 
 Select the Program Group option, and click OK. 
 
 The Program Group Properties Dialogue box appears. 
 
 Type "Beta Multicounter" in the description box and click OK. 
 
9. Click "New" from the File Menu. 
 
 Select the Program Item Option, and click OK. 
 
 The Program Item Properties Dialog Box appears. 
 
 Type "MCW" in the description box, and a:\mcw\mcw.exe in the Command Line  
 Box. Click OK. 
 
10.      You can now start the GM-25-5 multicounter program by double-clicking its icon. 
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The Beta Multicounter Window 
 

When you start MCW (Multicounter for Windows) the beta multicounter window appears 
in full-screen size. 
                      

             
 
 
 
 
 
Beta Multicounter Menus 
 

Like many Windows applications, the beta multicounter program has pull-down menus that 
list commands by name. 
 
Example: Click "Data" in the menu bar, and the "data pull-down menu" appears. 
 
The Beta multicounter include following pull-down menus: 
 
Data:                                 Run:                                          Setup: 
  View  MC1   MC1 
  Print view  MC2   MC2 
    MC3         MC3 
    MC4         MC4 
 
High voltage:                       Check: 
 MCI  MCI 
 MC2  MC2 
 MC3  MC3 
 MC4  MC4 
   Show data 
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The Data menu 
 
 The Data menu lets you view and print data files.  
 There are three types of files with extension:  
 
 SAM Sample files.  
 
 BAC Background files.  
  
 CAL Calibration files. 
 
View 
 
1. To view the data, click "Data" in the menu bar, and the "data pull-down" menu  
 appears. 
 
2.         Click "View" in the menu bar and the "File Open Dialog Box" appears. 
 
 
 
 
 
 

                                
 
 
 
 
 
 
 
3. From the list of files, select the file you want to open or if the file you want to  
 open is on a different drive or directory, then us the Directories box. 
 
4.        Double-click the file name or choose the OK button, and the View Window 
            appears. 
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By using the scroll bars, you can move parts of your data into view, if the entire  
data file is too large to be displayed. 

 
 

                 
 
 
 
 
 
Print view 
 
 1.        To print files click "Print view" in the menu bar, and the "File Open Dialog 
 Box" appears. 
 
 2.        From the list of files, select the file you want to print and the "print data file 
 window" appears. 
 
3. Click "Print" in the menu bar to print out data. 
 
 
 
The high voltage menu 
 

The High Voltage menu enables you to control the high voltage in ways  
"Manual" or "Auto". 

 
Click "High Voltage" in the menu bar, and the "high voltage pull-down" menu 
appears. 

 
Click "MC1" in the menu bar, and the "high voltage setting" window appears  

(MCI is multicounter number 1). 
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Auto control 
 

The "Auto Control" is a pulse-height analyzing system and is provided to auto- 
matically ensure that the high voltage is maintained at a proper value, i.e. well within 
the GM voltage plateau. 
 

Be sure that the "HV. man." LED located at the front of the 
Disc./anticoincidence module is switched off. If not, then press the "H.V. man" switch 
located at the rear of the Disc./anticoincidence module. 
 
   Place the 99Tc test source in position 5, the most distant hole while holding the 
green sample slide and push it into the GM multicounter (see text window). 
 
1. Select Auto in the control check box. 
 
2. Click the "Start" button in the "high voltage" window. The high voltage now 
 slowly increases. When the following text appears 
 
 "Plateau test finished" 
 
 then click the "OK" button. 
 
 The high voltage is now at the proper value. 
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Manual control 
 
 The "Manual control" is only used to check the GM multicounter. 
 
 
 
The Run Menu 
 
 The "Run" menu is used to select which GM counter to run.(MCl..MC4) 
 
1. To run GM multicounter l,forexample. Click "Run" in the menu bar, and the "run 
 pull-down" menu appears. 
 
2. Click "MCI" in the menu bar and the "file open dialog box" appears. 
 
                             
 
 

                          
 
 
 
 
3. In the File open box you select the "run info" file you want to open.  
 To make a new "run info" file, write the new name in the filename box  
 (the extension must be RIF). 
 
4. Double-click the file name or choose the OK button, and "The run information"  
 window appears. 
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In the "run information window" you can make your own settings. 
 
 General ID: Text to identify the measurements. 
 
 Preset time: Integration time for counting. 
 
       Preset cycles: Enter how many measurements you want. 
 
       Data path: Set drives and path for you data files. 
 
     Data name: Write your data file name here. 
 
    Select EXT.: You can select three types of extensions 
 
   "SAM" for Sample measurements.  
 "BAC" for Background measurements.  
 "CAL" for Calibration measurements. 
 
           Header: Short description of measurement. 
 
  Click the "OK" button, and the measurement window appears. 
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The measurement window is split up in windows. 
 
In the window at the top on left-hand, the five counters + the guard counter are marked, with 
corresponding counts (Integral), CPM, +/- % standard deviation, and last status. 
 
In the window below, the last ten measurements are displayed. 
 
To make a measurement, click the "start button" or "cancel" to quit the Window 
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The check menu 
 
 The "Check menu" enables you to check the efficiency and the backgound of each 
counter in the GM multicounter (MCI ..MC4). 
 In the "Background check window" you can set the "preset time" in min. (normally 
100 min.) and for the "Stability Check window" 5 min. for each measurement. 
 
 The check data will be shown graphically over a year. ("show data" menu). 
 
 The counter check is normally done once a week or month. 
 
1. To make a GM multicounter check, click "check" in the menu bar, and the 
 "check pull-down" menu bar appears. 
 
2. Click "MC1" (MC1-MC2) in the menu bar and the "counter check" window 
 appears. 
 

 
 
 
1. Place the background bricks in the multicounter as described in the text window. 
 
2. Click the "OK" button, and the "counter check measurement" window appears. 
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After end "background check" the "Counter check window" will appear.  

 
 
 

1. Type your preset time. 
 
2. Place the test source as described in the text window. 
 
3. Click the "OK" button, and the "counter check measurement" window appears. 
  
After all five channels are done the program will return to the main window. 
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The show data menu 
 

The "show data" menu is where you may view the efficiency of each counter in  
the GM multicounter within a year. 
 
1. Click "show data" in the "check pull-down" menu bar, and the "file open"  dialog 
 box  appears. 
 

                            
 
2. In the "file open" box you select the check file you want to open. (The extension 
 is "a" for multicounter and e.g."97" is the year). 
 
3.  Double-click the filename or choose the OK button, and the "view check data" menu 
appears. 
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The setup menu 
 

 The SET UP menu is a hardware and path setup window where you select the  
 numbers of counters (A, B, C, D) which depend on the actual counters you have 
 and path for Data, Check and Run info. 

 
 The GM-25-5 software for Windows is designed to operate four multicounters 
 independently at the same time. 
 
 In the check boxes you can select the number of counters you have available. 
 
 Click OK to escape the SETUP menu. 
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          SAMPLE PREPARATION 
 
Samples for beta counting are prepared on the enclosed nylon disc/rings which are according to the 
 
Health and Safety Laboratory Procedure Manual. HASL - 300 USAEC. 
 
 
 

                
 
 
The nylon sample disc/ring consists of: 
 
1. Nylon ring 
2. Nylon disc 
 

3. (Steel discs are provided for further reduction of the background and for reflection to improve counter 
efficiency (90Sr)). 

 
How to prepare a sample: 
 
1. Arrange a flat sample on the nylon disc (A) 
2. Cover the sample with Mylar foil (B) (1 mg/cm2) 
3. Press the ring around the disc to fix the Mylar foil and cut the Mylar foil  
    overhang with a pair of scissors (C) 
 
 
 

          
 
 
 
CAUTION! 
 
The total sample highs must not exceed 8 mm as the counter windows may be damaged. 
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1.   Two special lead bricks. 
2.   Delivered by RISØ. 
 
3.   Two (1.5 mm.) steel plates. 
      Delivered by RISØ 
   
 
TOTAL NUMBER OF LEAD BRICKS:  
Full size - (200 x 100 x 50 mm.) - 32 pcs.  
Half size- (100 x 100 x 50 mm.) - 6    pcs. 
Total weight of lead bricks: 385 Kg. 
 
      
     
  

 
 
 
SUGGESTED LEAD SHIELDING  
FOR BETA MULTICOUNTER     
MODEL RISØ GM - 25 - 5. 
 
 

 


